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Creating a Tool in Survey 123 Methodology 

The following outlines the methodology used to develop the Colorado Department of Transportation 
(CDOT) Federal First/Last Mile (FLM) Field Inventory tool in Survey 123. The field inventory tool is a 
powerful tool that captures the characteristics, location, and photos of deficiencies that can be used 
to identify improvements and display them on maps, in tables, and in documents. 

Survey 123 Overview 
Survey 123 is a GIS-based survey tool developed by ESRI, creator of ArcMap, ArcGIS Pro, and ArcGIS 
Online, among many other geospatial products. Survey 123 allows users to fill out surveys without an 
account online via a computer or a mobile device. Via mobile, user responses will have a GPS 
location attached, along with the option to attach photos. Data from survey responses can be easily 
exported to shapefiles or Excel files, and data can be visualized and shared using ArcGIS Online 
webmaps. For full documentation from ESRI, click Get Started with ArcGIS Survey123.  

Accessing Survey 123 Online 
To create a new survey or manage existing surveys, use survey123.arcgis.com. Figure 1 depicts an 
example of the “My Surveys” page after logging into Survey 123. 

Figure 1: Survey 123 My Surveys Page 

https://learn.arcgis.com/en/projects/get-started-with-arcgis-survey123/
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Developing a New Survey 
Once logged into Survey 123 and on the My Survey page, click New Survey to create a blank survey 
from scratch (Figure 2). 

Figure 2: Create a New Survey Screen 

Choose Blank Survey using the web designer, as shown on Figure 3. 

Figure 3: Blank Survey Option in Web Designer  
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Adding Questions to a Survey 
After you have selected Blank Survey in the web designer, a blank survey will display with a few 
sections as shown on Figure 4. In web designer, edit sections by clicking on them and entering 
information in the pane on the right side of the page. 

Figure 4: Blank Survey Panel 

Survey Name is the name that will display on the My Surveys page and can be seen by only the 
creator.  

Survey Title is the title shown at the top of the survey and seen by participants. Survey Title can be 
either text or an image and can be set on the Edit panel, as shown on Figure 5.  

Figure 5: Edit Panel for Survey Title 

Survey Name 

Survey Title 

Survey Description 
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Survey Description is a short descriptor to introduce the survey or provide instructions to users, as 
shown on Figure 6. 

Figure 6: Edit Panel for Survey Description 

The side panel also contains three buttons at the bottom: Saved, Preview, and Publish, as shown on 
Figure 7. Click Saved to save the edits to your survey so that you can come back to it later. Click 
Preview to preview the survey as if you were a user taking the survey. Click Publish to make the 
survey “live” to whatever audience you choose on the Collaborate tab. For this section, make sure 
to click Saved often so that you do not lose any changes. 

Figure 7: Save, Preview, and Publish Buttons 
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Several key question categories are used to develop an FLM Field Inventory survey. The question flow 
is as follows:  

• Identify an Issue Type (for example, a sidewalk issue, an intersection issue, or a bike lane issue).
• Describe the issue with a free response question.
• Specify the location of the issue on a map.
• Provide specific details about the issue (typically an optional free response or multiple-choice

question).
• Select potential recommendations (an optional multiple-choice question).

Figure 8 depicts an example of the completed question flow, and Appendix A has detailed 
recommendations for the language to use when setting up an FLM Field Inventory Survey.  

Figure 8: Example Survey Results 

To begin adding questions, click Add on the Survey Design page (Figure 9). 

Figure 9: Add Button on Survey Design Page 
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This example shows how to add a few single select choices, a description box, a map, and some 
secondary questions triggered from the Single select choice. To add a Single select choice question, 
click Single select under the Choice section, as shown on Figure 10. 

Figure 10: Single Select Question from the Choice Question Type 

On the Single select panel, edit the Label, Hint, and Choices options, as shown on Figure 11. The 
display to the left of the edit panel shows what the question will look like in the survey. 

Figure 11: Editing a Single Select Question Type 



FLM Survey 123 Methodology 

Page 7 

Scrolling down in the edit panel (Figure 12) gives some additional options such as Appearance (how 
the buttons are laid out), Validation (whether a question is required or not). and Behavior (whether 
a question is visible). The Behavior section also allows the creation of rules to allow visibility of the 
question after certain conditions are met. A later example shows how to create a question that is 
only visible after selecting a Sidewalk feature. At this time, make the question required and visible. 

Figure 12: Additional Edit Options 

Next, to add an issue description box, click Add in the side panel and select Multiline text as the 
question option under the Text, number, date, and time section. Figure 13 shows how the question 
is set up in the edit panel. 

Figure 13: Issue Description for a Multiline Text Question Type 
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Next, to add an option to map the location of the issue, click Add in the side panel and then click 
Map under the Location section. Figure 14 shows the options panel. Selection options include Point, 
Line, or Area (polygon). Since only one type of feature (point, line, area) can be mapped for each 
survey, a separate survey will need to be created if multiple feature types will be mapped. 

Figure 14: Options for Map Question Type 

Scroll down in the map panel (Figure 15) to choose a basemap and default extent for the map in the 
survey. Search for a specific address, or drag to the location you would like to show on the survey 
map. The display panel on the left updates to match. Click Edit for Map and extent to choose a 
different basemap. 

Figure 15: Additional Options for Map Question Type 
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Finally, you can create additional questions that will show up only when clicking the Sidewalk option 
in the first question using the visibility rules on the edit panel. This powerful feature allows you to 
design a survey to show different types of questions depending on choices made previously in the 
survey. It also leads to an easier experience for the survey user because they do not have to skip 
through unnecessary questions to fill out the question they would like. 

This example uses a Multiline text question type, but any question type can have custom rules 
applied to it to limit visibility based on previous answers. 

To add the question, click Add and then Multiline text for the question type as in the previous step. 
For this example, the question will be called Proposed solution to sidewalk issue. Scroll down on 
the edit panel to the Behavior section and click Set rule, as shown on Figure 16. 

Figure 16: Set Rule Button under Behavior 

On the Visibility rule menu, select the first question (What kind of feature has the issue?), then is, 
and then Sidewalk. These options make the question visible only when selecting Sidewalk in the first 
question. Figure 17 shows the selection for reference. 

Figure 17: Set Visibility Rules for a Question 
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After completing these steps, the survey should display as shown on Figure 18 when selecting the 
Sidewalk option. You can now add a survey name, title, and description; add new questions; and 
create visibility rules for questions. Appendix A provides a full list of the questions from the Federal 
Boulevard First/Last Mile Survey. 

Figure 18: Survey Results Example 
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Creating a Survey from a Previous Survey 
From the “My Surveys” main page, click the three dots in the lower right corner of the survey you 
would like to use as a template and when the dropdown appears, select Save as, as shown on 
Figure 19. The new survey will have the same design as the template but will start fresh with no 
results. 

Figure 19: Create a New Survey From a Previous Survey 

For more information, click Create a Survey. 

https://learn.arcgis.com/en/projects/get-started-with-arcgis-survey123/#create-a-survey
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Managing Your Survey 
On the My Surveys page, click on a survey to go to the dashboard for that survey (Figure 20). The 
dashboard page allows you to see an overview of your survey results thus far, to make changes to 
your survey design, to change the sharing settings, to analyze results, to view and export data, to 
change the overall survey settings, and to create a link for sharing the survey with participants.  

Figure 20: Sample Survey Dashboard Page for an Existing Survey 

Testing the Survey Tool on Mobile or Desktop 
To ensure that the survey opens in a browser on mobile and desktop, click on Collaborate on the 
survey dashboard. Then in the Share Survey section, select Open the survey in browser directly, as 
shown on Figure 21. 

Figure 21: Settings to Ensure the Survey Opens in a Browser 
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Go to the generated survey link or QR code to open the survey and create submissions for testing 
purposes. The link and QR code to the survey will look as show on Figure 22. To access the link for 
testing or sharing, click the Share button on the survey dashboard. A specific link and QR code for 
the survey display. Use either for testing or sharing with survey participants. Note: The survey must 
be published for a sharing link to be generated. 

Figure 22: Survey Link, QR Code, and Share Button 

Changing Permissions for Sharing the Survey 
To change permissions to allow others to participate in the survey, click on Collaborate on the 
survey dashboard. Under the Share Survey section, select who you would like to allow under the 
Who can submit to this survey? question. Choices include everyone (public) or only members of your 
organization or specific groups. Figure 23 displays the choices.  

Figure 23: Survey Permissions 

For more information, click Complete and Submit Survey. 

https://learn.arcgis.com/en/projects/get-started-with-arcgis-survey123/#complete-and-submit-the-survey
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Viewing Outputs from the Survey Tool 
Data collected from the survey tool automatically populates on the Analyze tab on the survey 
dashboard within the Survey 123 website where it can be analyzed in various ways (Figure 24). 

Figure 24: Word Cloud Created for Survey Question Results on the Analyze Tab 

As shown on Figure 25, results also automatically populate on ArcGIS Online using the same account 
information used to login to Survey 123. 

Figure 25: Feature Layer Automatically Created in ArcGIS Online from Survey Results 

Additionally, data can be exported as a spreadsheet or GIS data such as a shapefile or geodatabase 
on the Data tab on the survey dashboard, as shown on Figure 26. For more information about 
analyzing data from Survey 123, click Analyze Survey Data. 

Figure 26: Export Options on the Data Tab 

https://learn.arcgis.com/en/projects/get-started-with-arcgis-survey123/#analyze-survey-data
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Creating Webmaps from Survey Data 
Data submitted from surveys is hosted on your ArcGIS Online account in the form of “Feature Layers” 
(points/lines/polygons) and a “Form” (the survey form), as shown on Figure 27. 

Figure 27: Data Created on ArcGIS Online from Survey 123 

Once the data is hosted on ArcGIS Online, webmaps can be created to display the data in an 
interactive format that can be explored by anyone who has a link to the webmap. An example of 
some results mapped in a webmap can be found here and on Figure 28.  

Figure 28: Data Created in Survey 123 in a Webmap 

https://fhu.maps.arcgis.com/apps/instant/basic/index.html?appid=b7d866c4ed3a4ea0a53dbf0e0a21ed74
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To create a webmap in ArcGIS Online, click on a Feature Layer and add it to a new map using the 
dropdown arrow on the right side of the Open in Map Viewer Classic button shown on Figure 29. 

Figure 29: Dropdown Menu for Creating Maps From a Feature Layer in ArcGIS Online 

For more information, click Share Your Survey Data. 

Opening an Existing Survey Using ArcGIS 
Survey 123 Connect App 
Currently, to transfer a survey from one account to another, a standalone app called ArcGIS 
Survey 123 Connect must be used. This application can be downloaded from the Microsoft Store. 
Note: Transferring the survey to the app disables the ability to edit the survey in the web 
designer on survey123.arcgis.com. All future edits to the transferred survey must be made in 
the Survey 123 Connect app, although survey results will still show up on the survey dashboard 
and on ArcGIS Online. 

Open the Survey 123 Connect app, click the hamburger button, and sign in as shown on Figure 30. 

Figure 30: Sign in on Survey 123 Connect App 

https://learn.arcgis.com/en/projects/get-started-with-arcgis-survey123/#share-your-survey-data
https://apps.microsoft.com/detail/9pmst5c0dlst?rtc=1&hl=en-US&gl=US
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To open a survey from another account, the other account user must download the survey to a .xlsx 
file and send that to you. Click the cloud icon on a survey from the Survey123 Connect app main 
page, as shown on Figure 31. 

Figure 31: Survey Download Button in Survey 123 Connect 

Once the survey is downloaded, a .xlsx file will be generated on the user’s hard drive containing the 
survey and this can be shared to be opened on another account. To open the .xlsx file containing the 
survey on a new account, click the + New survey button, as shown on Figure 32), and then select 
the Create a new survey from file option to open the .xlsx file, as shown on Figure 33. 

Figure 32: + New Survey Button in Survey 123 Connect 
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Figure 33: File Option under the New Survey Button in Survey 123 Connect 

From here, you can edit and publish the survey. However, the workflow has some differences from 
that of the Survey 123 web designer discussed previously. Although the workflow is not as 
user-friendly as that of the web designer, the Survey 123 Connect app allows much more 
customization of surveys, if desired. For full documentation on how to create, manage, edit, and 
publish surveys in the Survey 123 Connect app, click Survey 123 Beginner's Workflow.  

https://community.esri.com/t5/arcgis-survey123-blog/survey123-connect-beginner-s-workflow-configure/ba-p/1146839
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Appendix A. Federal FLM Point Survey 
Questions 

Below is the full list of questions that make up the Federal Blvd First/Last Mile Site Visit Point 
Survey. The list is organized into global questions (always visible) and the Issue Type categories and 
the questions visible based on the selection of those categories. The question type as categorized in 
Survey 123 is also listed, along with whether the question is required. 

Global Questions/Sections 

• Survey Header
• CDOT Logo Image

• Survey Description
• Name (Question type: Singleline text, required)

• For entering survey participant’s name

• Issue Type (Question type: Single select, required)
• The Issue Types that should be added include:

• Pedestrian Network Barrier
• Intersection Design/Safety Issue

• Sidewalk Gap

• Trail Gap

• Frequent Curb Cuts

• Mid-Block Crossing Design/Safety Issue

• High Vehicle Speeds

• Lighting and Visibility Issue
• Existing Bike Facilities: Intersection Design/Safety Issue

• Bike/Micromobility Parking Issue

• Green Infrastructure or Streetscape Issue

• Shared Mobility Services: Microtransit

• Shared Mobility Services: Micromobility (Scooter and Bike Share) Issue

• Connectivity Issue to Other Transit Routes and Services

• Other

• Note: Unique subcategories should be added under each Issue Type. These are provided in the
Subcategories for Issue Type section.

• Issue Location Map (Question type: Map, required)
• Issue Description (Question type: Multiline text, required)
• Issue Photos 1-5 (Question type: Image)

• Users can take/upload photos of the observed issue



FLM Survey 123 Methodology 

Page A-2 

Subcategories for Issue Type 
Each Issue Type should include unique follow-up questions (detailed below). All subcategories are 
visible only if selecting the main category. Issues Observed and Recommended Improvements 
questions were left as optional as they are a supplement to the required global Issue Description 
question. 

Subcategories for Issue Type: Pedestrian Network Barrier 

• Description (Question type: Note)
• Identify other barriers in the pedestrian network that may impede first/last mile accessibility

• Issues Observed (Question type: Multiline text)
• Recommended Improvements (Question type: Multiline text)

Subcategories for Issue Type: Intersection Design/Safety Issue

• Description (Question type: Note)
• Identify safety deficiencies at intersections that could be mitigated to improve first/last mile

accessibility
• Issues Observed (Question type: Multiple select)

• Traffic Signal and crosswalk timing
• Infrastructure (curb ramps, curb radii, medians, crosswalks and other striping, etc.)
• Sightlines/Visibility
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)

• Signal timing adjustment to increase leading pedestrian interval
• High visibility crosswalk striping
• Median extensions and pedestrian islands
• Reduced curb radii
• ADA compliant curb ramps
• Intersection daylighting
• Other
• Allow “Other” – Add a text description (select this box to add text details)
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Subcategories for Issue Type: Sidewalk Gap 

• Description (Question type: Note)
• Identify deficiencies and gaps in the existing sidewalk network that may form first/mile

accessibility barriers for those walking or rolling
• Issues Observed (Question type: Multiple select)

• Gap in sidewalk
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)
• Fill sidewalk gap
• Other
• Allow “Other” - Add a text description (select this box to add text details)

Subcategories for Issue Type: Trail Gap 

• Description (Question type: Note)

• Identify deficiencies and gaps in the existing trail network that may form first/mile
accessibility barriers for those walking, rolling, or biking on trails.

• Issues Observed (Question type: Multiple select)

• Gap in trail
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)

• Fill trail gap
• Other
• Allow “Other” - Add a text description (select this box to add text details)

Subcategories for Issue Type: Frequent Curb Cuts 

• Description (Question type: Note)

• Identify areas of the network with frequent or poorly designed curb cuts that may form
first/mile accessibility barriers for those walking, rolling, or using mobility devices

• Issues Observed (Question type: Multiline text)

• Recommended Improvements (Question type: Multiple select)

• Close driveway
• Consolidate existing curb cuts
• Narrow curb cut distance
• Other
• Allow “Other” - Add a text description (select this box to add text details)
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Subcategories for Issue Type: Mid-Block Crossing Design/Safety 
Issue 

• Description (Question type: Note)

• Identify safety deficiencies at mid-block crossings that could be mitigated to improve
first/last mile accessibility.

• Issues Observed (Question type: Multiple select)

• Signal and crosswalk timing (if signalized)
• Infrastructure (curb ramps, curb radii, medians, crosswalks and other striping, etc.)
• Sightlines/Visibility
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)

• RRFB or HAWK signal
• High visibility crosswalk striping
• Median extensions and pedestrian islands
• Reduced pedestrian crossing distance through lane narrowing, dedicated turn lane removal,

or bulb-outs
• ADA compliant curb ramps
• Daylighting
• Other
• Allow “Other” - Add a text description (select this box to add text details)

Subcategories for Issue Type: High Vehicle Speeds 

• Description (Question type: Note)

• Identify areas that are unsafe due to high vehicle speeds that may be mitigated with traffic
calming or other design improvements

• Issues Observed (Question type: Multiple select)

• Current speed limit
• Observed vehicle speeds
• Existing design elements to limit speeds (speed humps, chicanes, etc.)
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)

• Traffic calming elements (speed humps, chicanes, pinch points, diverters, other)
• Cross-section modification (travel lane narrowing, travel lane removal, other)
• Other
• Allow “Other” - Add a text description (select this box to add text details)
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Subcategories for Issue Type: Lighting and Visibility Issue 

• Description (Question type: Note)
• Identify current lighting and visibility issues that may lead to safety concerns within the

walkshed area, and recommend improvements to address these safety concerns
• Issues Observed (Question type: Multiline text)
• Recommended Improvements (Question type: Multiple select)

• New streetlighting
• Improvements to existing streetlighting
• Other
• Allow “Other” - Add a text description (select this box to add text details)

Subcategories for Issue Type: Existing Bike Facilities: 
Intersection Design/Safety Issue 

• Description (Question type: Note)
• Identify existing bike facility safety issues at intersections that may impede first/last mile

accessibility for bicyclists and micromobility users
• Issues Observed (Question type: Multiple select)

• Existing bikeway design at intersection
• Existing bikeway/intersection safety elements
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)
• Intersection geometry modifications to allow bike lanes to continue through intersection
• Bike conflict markings through the intersection
• Bike boxes at intersection
• Dedicated bike signal phase and/or right turn restrictions
• Other
• Allow “Other” - Add a text description (select this box to add text details)
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Subcategories for Issue Type: Bike/Micromobility Parking Issue 

• Description (Question type: Note)
• Identify existing bike and micromobility parking in the walkshed and at key destinations that

may benefit first/last mile accessibility
• Issues Observed (Question type: Multiple select)

• Existing quality and condition
• Bike rack design does not allow for secure locking (bikes not locked up properly, locked bikes

blocking spaces, evidence of tampering/theft, etc.)
• Insufficient bike parking
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)

• New or additional bike/micromobility parking
• Improvements to existing bike/micromobility parking
• Other
• Allow “Other” - Add a text description (select this box to add text details)

Subcategories for Issue Type: Green Infrastructure or Streetscape 
Issue 

• Description (Question type: Note)

• Identify green infrastructure and streetscape elements that either exist today or could be
added to improve the first/last mile experience within the walkshed

• Issues Observed (Question type: Multiple select)

• Lack of existing tree canopy and street shade
• Lack of existing streetscape amenities (benches, wayfinding signage, etc.)
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)

• Tree canopy and other street shade improvements
• New streetscape amenities
• Improvements to streetscape amenities.
• Other
• Allow “Other” - Add a text description (select this box to add text details)
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Subcategories for Issue Type: Shared Mobility Services: 
Microtransit 

• Description (Question type: Note)
• Microtransit is an app-enabled transit service that typically uses multi-passenger/pooled

shuttles or vans to provide on-demand or fixed-schedule services. Conduct a desktop analysis
and field observations to understand if a microtransit service is currently operating within the
walkshed site area or near the walkshed site area (and if a microtransit service is operating,
how effective it currently is).

• Issues Observed (Question type: Multiple select)
• A microtransit service operates nearby but does not currently serve this station area walkshed
• The existing shared mobility service within the walkshed does not currently meet community

needs (insufficient service hours, insufficient service to key destinations, unreliable service,
unaffordable costs etc.)

• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)
• Expand existing microtransit program service area to serve the station area walkshed
• Modify existing microtransit program to better meet community needs
• Other
• Allow “Other” - Add a text description (select this box to add text details)

Subcategories for Issue Type: Shared Mobility Services: 
Micromobility (Scooter and Bike Share) Issue 

• Description (Question type: Note)
• Conduct a desktop analysis and field observations to understand if a micromobility service is

currently operating within the walkshed site area or near the walkshed site area (and if a
micromobility service is operating, how effective it currently is)

• Issues Observed (Question type: Multiple select)
• A nearby micromobility service does not currently serve this walkshed
• The current micromobility service that serves this walkshed does not have a sufficient level of

vehicles (shared scooters or bikes) to meet demand
• There are insufficient parking locations for micromobility vehicles in the walkshed
• Micromobility vehicles are being parked improperly and blocking sidewalks, trails, etc.
• Micromobility vehicles are being ridden on sidewalks or other areas they are not permitted
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)
• Expand existing micromobility program to serve the station area walkshed
• Improve micromobility vehicle availability
• Improve/expand designated micromobility parking locations
• Improve bike/micromobility facilities to reduce sidewalk riding.
• Other
• Allow “Other” - Add a text description (select this box to add text details)



FLM Survey 123 Methodology 

Page A-8 

Subcategories for Issue Type: Connectivity Issue to Other Transit 
Routes and Services 

• Description (Question type: Note)
• Issues Observed (Question type: Multiple select)

• Long distances or indirect connections when transferring between bus routes or rail lines
• Transit wayfinding signage missing
• Transit stop quality/amenities (for stops/routes that are not already being upgraded as part

of the BRT project)
• Other
• Allow “Other” - Add a text description (select this box to add text details)

• Recommended Improvements (Question type: Multiple select)
• Improve connectivity between bus routes or rail lines
• Improve transit service wayfinding
• Improve transit stop amenities (for stops/routes that are not already being upgraded as part

of the BRT project)
• Other
• Allow “Other” - Add a text description (select this box to add text details)

Subcategories for Issue Type: Other 

• Description (Question type: Note)
• Identify any other key elements or considerations within the walkshed that do not fit into the

other categories

• Issues Observed (Question type: Multiline text)
• Recommended Improvements (Question type: Multiline text)
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